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REGULATORY NOTICES

Federal Communications Commission Notice

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and radiate ratio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation.

MACAUTION!

&

CAUTION! Danger of explosion if an improper battery is substituted. If a
replacement is needed, only replace with a manufacturer issued battery pack.

/A Do not dispose of the battery pack in a fire. They may explode. Check with local
authorities for proper disposal instructions.
ESD WARNING!

The USB function may be break down during electrostatic discharge interference. Please
suspend or reset the system to enable the USB function.
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USER GUIDE

1.Getting Started

1.1Welcome
Congratulations! With your new Web Tablet you will be able to create, manage and
share information, send and receive email, and carry out research from virtually
anywhere! Your Web Tablet gives you freedom; easy access to the Internet, and the

800X600 SVGA screen offers high resolution for all your Tablet uses.

This manual will guide you through the Tablet’s simple set-up, introduce you to its
range of features and help you source extra information.

1.2Safety Instructions and Care of your Web Tablet

A CAUTION! Danger of explosion if an improper battery is substituted. If a

replacement is needed, only replace with a manufacturer issued battery pack.
During normal usage and charging, the battery pack heats up. This is caused
by energy that has been generated and a chemical charge that has occurred
inside the battery pack. This is not cause for concern.

You should charge batteries at temperatures from 10°C to 30°C (from 50 °F to
85 °F). Lower temperatures require a longer charging time.

Do not carry a battery in your pocket, purse, or other container where metal
objects could short-circuit the battery pack. The resulting excessive current
flow can cause extremely high temperatures and may result in damage from
burns.

Do not use your Web Tablet in a wet environment, for instance, near a bathtub,
sink, or any other place where there is risk of moisture.

To help prevent electric shock, plug the AC adapter into a three prong,
grounded power source. If a two-prong extension plug is absolutely needed,
use a 3-wire cable with properly grounded plugs.

If your Web Tablet includes a modem PC Card, disconnect the modem cable
during electrical storms to avoid the remote risk of electrical shock from
lightning via the telephone line.

PC Cards may increase in temperature over an extended period of use. Use
care in handling these cards.

A Do not dispose of the battery pack in a fire. They may explode. Check with

local authorities fro-proper disposal instructions.

When traveling, never check your Web Tablet as baggage. You can put your
Web Tablet through an x-ray security machine, but never put your Web Tablet
through a metal detector. Have a charged battery with you in case you are
asked to turn on the Tablet.



e When traveling, do not place the Web Tablet in an overhead compartment
where it can slide around. Do not drop your Web Tablet or subject it to
mechanical shocks.

e Protect your Web Tablet from environmental hazards such as dirt, dust, food,
liquids, temperature extremes, and over exposure to sunlight.

e  When you change environments rapidly, in respect to temperature and
humidity, with your Web Tablet, condensation may form on or within the
Tablet. To avoid potential damage to your Web Tablet, allow sufficient time
for the moisture to evaporate before using.

e When disconnecting cables from your Web Tablet, be sure to pull on the
connector or the strain relief loop, not on the cable itself. As you pull, keep it
evenly aligned to avoid bending the connector pins. Never force a connector
into a port. Make sure the connector and port are aligned correctly.

e Before you clean your Web Tablet, turn it off, remove the battery, and unplug
the power source.

e Clean your computer with a soft cloth dampened with water rather than with
liquid or aerosol cleaners.

e (lean the screen with a soft, clean cloth and commercial window cleaner that
does not contain wax or abrasives. Always apply the cleaner to the cloth, not
the screen. If the display contains grease or some other contaminant, use
isopropyl alcohol instead of commercial cleaner.

1.3Checklist
Check to see that the package your Web Tablet came in includes these items:

Web Tablet

AC Adapter

Power Cord

Battery Pack

Stylus

Utility CD
Synchronization Cable
Mini-VGA Cable
Carry Bag

1.4Getting to Know Your Web Tablet
Your Web Tablet features powerful functions and connectivity for you to create,
manage and transfer your information, send and receive email and explore the World
Wide Web. This section outlines your Web Tablet’s components.
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PCMCIA Slot
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On/Off Switch

CompactFlash Card / IBM Microdrive™ Slot
Software Reset Button
Stylus Storage
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External Microphone Jack
External Speaker Jack
Infrared Port (IrDA)

Page Up/Down Dial




Back

1. Cover to Hardware Reset Button
2. Cradle Dock / Synchronize Cable Port
3. Battery Latches

Front

1. Speaker

2. Control Buttons

3. Power Indicator

4. Battery Indicator

5. Internal Microphone
6. Battery Pack
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1.5The Battery and AC Adapter
Your Web Tablet has two power sources, battery and AC. To run your Web Tablet
from the wall, use the supplied AC adapter cable only. The battery offers you
unplugged convenience, with as much as 5 hours of battery life, extendable to 10
hours with the optional long-life battery pack. The battery charges when the Tablet is



connected to the AC power. The orange indicator on the front of your Web Tablet
indicates the battery’s status.
Charging Time with standard battery pack: 2 hours fast charge mode (system off)
2.8 hours normal charge mode (system on)
Charging Time with long-life battery pack: 2.8 hours fast charge mode (system off)
4.6 hours normal charge mode (system on)

e

e Indicator orange: Battery is charging
e Indicator blinking: Low Battery (Less than 6% charge remaining)
e Indicator off: Battery is fully charged

Lock &> Unlock

When fully charged and not in use, your Web Tablet battery has a one week life.
When turning on your Web Tablet but it goes to suspend immediately, that means the
battery volume is 0%. Please charge your Tablet within one day, or you will lose all
data in memory.

Please suspend your Tablet before removing or changing the battery pack and plug
back the charged battery with 15 munutes, or you will lose all data in memory.

To check your battery level, or to adjust the time before your battery switches off
after the Tablet is continuously idle, go to Start—Settings—Control Panel->Power.

For further tips on optimizing your battery, go to Start—Help—Settings—>Power.



1.6 The Stylus
The Stylus has been specially designed for use with your Web Tablet.

IMPORTANT: It is strongly recommended that you use the provided stylus at all
times; fingers or other instruments may damage your screen.

If you find that your Web Tablet is not responding properly to your taps, you may
need to recalibrate your screen. To do this, go to Start—Settings—Control
Panel—Stylus. Once there, go to the calibration tab and follow the instructions.

Your stylus can be conveniently stored in the side of your Web Tablet.

1.7Using the PCMCIA Slot and CompactFlash Cards

The PCMCIA slot is a universal interface for many different hardware peripherals.
This slot can accommodate any PC Card that is supported by Windows CE 3.0. One
of the key uses for this slot is the wireless card, which will be discussed further, later
in this document.




The CompactFlash slot, shown above, is a Type II slot that can accommodate any
IBM Microdrives™ and Type I and Type II CompactFlash cards that are supported by
Windows CE 3.0.

1.8Web Tablet Buttons
The buttons on the front of your Web Tablet gives you greater navigational control.

The BCEF buttons function as arrow keys, but can also be used as a mouse. These
keys as well as the D key will resume the Web Tablet from ‘suspend’” mode.

A — Launch Dial Button — opens the launch dial program.
D — Launches the last program; acts as ‘right click’ or ‘enter’ button.
G —Toggles (B, C, E& F) between arrow key functionality and mouse functionality.

The ON/OFF switch on the side of your Web Tablet, when in the OFF position,
ensures that the Tablet isn’t accidentally turned on. Sliding the switch to the ON
position resumes the Tablet.

The Page Up/Down switch on the side of your Web Tablet lets you easily scroll
pages, including web sites and documents. Any application that uses a scroll bar can
use this switch.

1.9Display Properties
This function allows you to set the background on your desktop, and the colors
displayed on your interface. To access these functions, go to

Start—Settings—Control Panel»Display—Background
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1.10 The Cradle (Optional)
The cradle lets you ‘dock’ your web Tablet, making it easy to use your desk, to read
information, or to add peripherals such as a keyboard or a mouse.

1. ACin

1. USB Ports

1 2 3

1. PS/2 Ports
2. USB Type B Port
3. USB Ports

In addition, the cradle increases your connectivity, with USB Type A and B (for
synchronization with your PC) ports [4 A-Type and 1 B-Type] as well as PS/2
support for a keyboard and mouse. By removing the insert in the cradle’s pocket (by

sliding the insert to the right and lifting it up), the cradle can accommodate Web
Tablets with the extended battery.
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2.Managing Your Information Data Input

2.1Data Input
Your Web Tablet features a variety of data input methods, so you can choose, and
change, according to your needs:

e Handwriting Recognition.
e A Software Keyboard.
e An External Keyboard.

Handwriting
Using the stylus, you can directly write onto the screen, and your data will be quickly

converted. To set up the handwriting recognition, click on the @ icon in our
Tablet’s taskbar. A floating palette will appear, and by clicking on ‘Setting’ you can
choose how the palette looks, and where you can write on the screen. You can also
select the writing speed, width of pen and the color that will appear.

When the system is in use, the E icon will appear in the taskbar.
For a guide to writing for your Web Tablet, see

Quick tips for better handwriting recognition:

e Spend time ‘training’ your Web Tablet — everyone’s handwriting is individual,
and it will take a short time for yours to be recognized.

e When you write on the screen, the closest letter will be selected to appear on
screen. Other possibilities will appear in the boxes in the palette. If one of
these is correct, click on it and it will be remembered for next time.

e You can switch between upper and lower case, numbers, and punctuation by
simply clicking on the box next to ‘Setting’ on the floating palette. You can
also use the boxes at the top of the palette.

e To correct a mistake, create a space or go to a new line, use the boxes on the
palette.

e Exiting the handwriting recognition mode is as easy as tapping the
handwriting recognition icon in the taskbar.

Software Keyboard
To access the Software Keyboard, click the handwriting recognition icon in the
taskbar. Once this application comes up, click the keyboard icon in the top left corner

of the frame.

The Software Keyboard functions like a real keyboard. The ‘CAP’ key locks the keys
to uppercase; the ‘Shift’ key switches the keys to uppercase for one click only;
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shortcut keys, such as ‘Copy’ (Ctl+C) are controlled by touching the ‘Ctl’, then the
relevant key.

Once finished with the keyboard, click the ‘Close’ icon in the top right corner of the
keyboard window.

External Keyboard

Attaching an external keyboard via the USB port of the Tablet, or through the cradle,

overrides any other input selection. Make sure the keyboard is supported by
Windows CE 3.0 or comes with Windows CE 3.0 drivers. See

2.2Data Synchronization
To share information between your Web Tablet and your PC/Laptop, you need to
establish a direct PC Connection. There are two ways to make direct connection. The
default way is through USB interface.

The installation procedure is:
1. For make the connection, you will need to install the ActiveSync 3.1 (or higher)
software to your PC/Laptop. To download this freeware, go to

http://www.microsoft.com/mobile/downloads/activesync.asp

2. Install the Pocket On-Schedule Synch software to your PC/Laptop. This software is
in the bundled utility CD.

3. Using the synchronization cable to connect the PC/Laptop and Table. Both
PC/Laptop and Tablet will detect the connection and launch the counterpart software
to make the connection.

4. When finishing the connection, there will be a pop-up windows showing: ”Set Up a
Partnership”. Please select “No” and “next”. Now you have established the
connection successfully.

Please read the read me file together with the Pocket On-Schedule synch in Utility
CD to understand the detail of Pocket On-Schedule synch.
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The other way to make the connection is through IrDA. To switch between
connection interfaces, go to Start—Settings—Control Panel - Communication
—PC Connection, and follow the instructions. Place your Tablet and the target
device in line of sight of each other and within 1 meter apart. Then go to
Start—Programs—Communication—IR Sync to make the connection.

2.3Applications
Your Web Tablet has a suite of applications designed to create, share, and manage
your information.

With Task Manager, you can easily manage your working environment. The
Application Frame lists all the current applications in use. From here, you can switch
from application to application or close those that are unwanted. The Process Frame
lists all applications currently performing a task, including hidden applications
although these cannot be edited. Task Manager can be found by going to:
Start—Programs—Accessories—Task Manager

ltems
Listhox
Sample

tab tab tab

End Task Switch To
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Listhiox
Sample
tab tab tab

End Task Switch To

Launch Dial is a customizable navigation tool where you can load your favorite
applications for easy access. Use the Launch Dial’s arrow keys to locate your selected
application on the dial, or to add or remove applications. You can move the Launch
Dial anywhere on your screen, and use either the stylus or keypad to select
applications. The page up/down dial on the side of your Tablet moves up or down
two applications. You can launch an application by hitting the enter button or
selecting OK in the Launch Dial window.

The Launch Dial has five default applications, (Internet Explorer, PocketWord,
Explorer, Inbox, and PIM) along with three default icons, (Add, Delete, and Hide).
Users can add up to five further applications.

BI Hides the Launch Dial

o

% Launches a Dialogue box for the user to select an application to be added. Select
the Folder the application to be added is in (the name will appear in the ‘Path’
window); select the application by double-clicking twice with the stylus. You can
also navigate the Add Applications Dialogue box using the arrow buttons. The enter
and right buttons will add the selected application to the Launch Dial, and the right
button will automatically open the application. The left button skips to the upper path
or exits, if the path is at the root.

ﬁ Launches a Dialogue box for the user to select an application to be deleted. You
may only delete applications you have added; default applications cannot be deleted.
Select the application to remove, click on it twice, and the Launch Dial will re-appear
without the selected application. To return to the Launch Dial without removing any
applications, select “EXIT”. Remove Applications can also be navigated with the
arrow keys, as for Add Applications.
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Your Web Tablet comes with an MP3 player, letting you quickly start playing your
favorite tracks.

VRN bW =

10.
11.
12.

12 3 45 6

MP3 Player -- Medium Quality
|

12 1" 10 9

Pause

Next

Play

Loop

Previous

Stop

Options
PlayList Area*
Balance Control
Volume Control
Progress Slider
Track Information

*PlayList file stores all files as displayed in the play list area in a .pls file.
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Voice Recorder allows you to directly record your voice on to your Web Tablet, so
you can create sound files or send voice messages. Before recording, you can set
parameters, including the name of the recording, via the Properties window.

Voice Recorder

Volume Control
Previous

Next

Record/Stop
Progress Indicator
Play

S e

Picture Viewer allows you to open picture files — Bitmap, JPEG, TIFF, and GIF files.
Picture Viewer has two frames, the browser frame, with file directory, file list, and

thumbnail,
File View About |E”7
23 My Computer Marme [ twee [ see|  [a
(0 My Documents (] Desktop Foilder
(8 NETWORK (Caprograms Folder
(03 Program Files (CIRecent: Folder
D iEEmEd (CAFavoritss Folder
0 Temp CiHep Folder
E"a Windows sty Fald
-+ Deskinp e older
4 (1] Favorites Folder
[t GIF 1 KBytes
-2 Help 28P 1 Khytes
(2 Pragrarms 8P 1 KBytes
++(Z] Recent. 28R 1 KBytes
o] Startlp 8P 1 KBytes
28P 1 KBvtes
28P 1 KBytes 3
2BP 1 KBytes
28P 1 KBytes
28P 1 KBvies oo
2BP 1 KBytes
8P 1 KBytes
28P 1 KBvtes
Bitnap 19 KBytes
5 2BP 227 KBytes
28P 37 EBytes
ﬁlnk,Memo-z.sz 2BP 118 KBytes
2BP 39 KBytes
8P 2 KBytes
28P 2 KBytes
28P 2 KBytes
2BP 46 KBytes
JMPR Plaver 2hn j=1=] 4Pt b
1 files selected |1999/7/28 15:43 18682 Bytes
| #Rstart | IRemote Metworking || woice Recorcer [[Farictre viewsr [Raf4 2 & 1oarm lﬁl
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1. Open File

2. View Frame
3. File List

4. Thumbnail
5.

File Directory

and a View Frame, used to display the pictures selected in the Browser Frame.

Eile View Tools About (2] [x]

W incowsiwince bmp eeE2Eyes  BMP |31K11
#Rtart || Remote Metwarking || voice Recorder |[arictre viewer Rte2 @ rovem [A]

The view frame allows you to choose to shrink the image to fit on screen
(View—Shrink to fit Screen); to use the entire screen (View—Full Screen). Note
that Full Screen will not hide the Taskbar. To do this, go to
Start—Settings—Taskbar.

Using Slide Show you can select several images to view. To set the duration for each

image, from View Frame, go to Tools—Options.

File View Tools About

Sequence
@ Foward
O Reverse
) Random
[/] Full Screen

fWindows\wince.brmp JJ

Seconds

Winedows\wincs,brp 19662Bytes  [BMP [311x119
Hstart || ERemote Networking || voice Recorder [[Fapicture viewer Faf# 23 107pm @

Currently, Picture Viewer does not support the ‘Save As’ functions.
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Ink Memo

User can create a new memo or load from image files before drawing. It can be done
by selecting New or Open from File drop-down menu. User can also select the button
from Toolbar to new or open a memo. When finished, select Save or Save As from
File menu to save the memo.

Menu Tool Bar Pen Style Area

File Edit About DlD = EE Hlﬁ

[x]

m—— Pen Color Setting

I
EOEE

s
=l Pen Width Setting
=

Erasure

ifstart | Mavigation Ca... || Elnbox Suntited - ... | Zgmy computer | Suntited - . [ 1k Mo [Raf4 2 & 324 P11

Toolbar has 6 shortcuts including New Landscape Memo, New Portrait Memo,
Horizontal Grid, Vertical Grid, Open File, Save File and Append Memo.

New Portrait Memo

Horizontal Grid
New Landscape Memo / Vertical Grid

=) [} (5] )= 151

Oper File Append Memo

Save File

New

This tool allows user to select landscape memo or portrait memo. The default
resolution for landscape memo is 736*530 pixels, for portrait memo is 544*725
pixels.

This tool allows user to select the horizontal grid or vertical grid. It also can be found
in Edit menu.
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Open File

This tool allows user to open a memo that was previous saved or a standard 16 color
bitmap file by clicking the Open button on Toolbar or from File menu. When
clicking Open, a dialog box appears to allow user to open a selected file.

open ] | 2] o] ]
(2] \Windows\

_1Desktop [_JPrograms

A Favorites [_JRecent
_1Fonts [ StartUp
_1Heln =] wince.brmp
Profiles
Mame: | Type: [Bitman Files (*bmp) =]

Note: Ink Memo only supports 16 colors bitmap file. If user attempts to open a
bitmap that is not 16 colors, error messages will pop-up.

Save File

This tool allows user to save the file as the existing file name by clicking Save. Or
you can save the file as the other file names depending on what you need by clicking
Save As.

|Append Memo|

This tool allows user to enlarge the memo size, like the function that inserting the
new memo to the original one. This also can be found in Edit menu.

Pen Stylel

This tool allows user to select different types of pen color and pen width while
drawing. Once you touch the pen color or pen width, the Pen Style area will display
the tool you selected. Ink Memo supports 16 colors and 4 kinds of pen width. The
default color setting is black.

You can use Calculator in standard view to perform simple calculations.

To perform a simple calculation|

1.Enter the first number in the calculation.

2.Click + to add, - to subtract, * to multiply, or / to divide.
3.Enter the next number in the calculation.

4.Enter any remaining operators and numbers.

5.Click =.

« To work with numbers stored in memory
= Other operators

20



Calculator B m m

| 0.
Backspace CE
MC 7 8 g { sqrt
MR 4 | 6 e %
MS 1 2 = - 1fx
M+ 0 +f- . 4+ =

Other operators|

1.C clears the current calculation

2.CE clears the displayed number

3.Backspace deletes the last digit of the displayed number

4.0-9 puts the number in the calculator display

5.+/- changes the sign of the displayed number

6.. inserts a decimal point

7.8Sqrt calculates the square root of the displayed number

8.1/x calculates the reciprocal of the displayed number

9.% displays the result of multiplication as a percentage

10. MS stores the displayed number

11. MR recalls a stored number

12.MC clears the memory

13. M+ adds the displayed number to the number already in
memory

14.=performs any operation on the previous two numbers. To
repeat the last operation, click again.

15./ Divide

16.* Multiply

17.- Subtract

18.+ Add

% Example

1. Enter one number, click *, enter the second number, and then click %. For
example, 50 * 25% will display 12.5.

2. You can also perform operations with percentages. Enter one number, click the
operator (+,-,* or /), enter the second number, click %, and then click =, For
example, 50 + 25%(of 50) = 62.5.

[To work with numbers stored in memory|

« MSstores the displayed number
= MRrecalls a stored number



» MCclears the memory
» M+adds the displayed number to the number already stored in memory

Note: When you store a number, an M appears in the box above the memory
options. If you store another number, it replaces the one currently stored in the
memory.

An operator is a symbol that represents an operation. You can use the following four
operations in standard calculations

/ Divide

* Multiply
- Subtract
+Add

Applications in Brief

Primer is a PDF (portable document format) reader, which means you can read
documents with their original formatting in place. Any .pdf file you receive as
attachments or download from the Internet can be read with this application. For more
information, see http://www.ansyr.com/products/primerppc.asp

PTab is a fully functional spreadsheet designed for use with Windows CE. You can
use it to create spreadsheets and share the information with Excel files on your PC.
For more information, visit http://www.z4soft.com/

Pocket On-Schedule lets you manage your contacts, appointments and tasks. It
works as a journal, phonebook, and calendar. For more information, visit
http://www.odysseyinc.com/products/pocketos/default.htm

Notepad lets you create, open and update notepad files.

Pocket Word works much like Word 97 or Word 2000. It supports TrueType fonts,

simple formatting, and can display embedded image files. It can’t display other types
of embedded files, and doesn’t support headers, footers, footnotes, captions, indexes

or comments.

Windows Media Player lets you explore the full potential of the World Wide Web,
playing streaming media, including video and audio.

Internet Explorer is designed to give the full experience of the World Wide Web,
but using less system resources than the full version of Internet Explorer.
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PowerPoint is not supported with Windows CE 3.0, although you can publish
your .ppt files to HTML pages on your PC and use these files in the Pocket IE
provided on the Web Tablet.

3.Connecting Other Devices

Your Web Tablet is designed to support a number of external devices. As stated
earlier, the devices need to be compatible with the Windows CE 3.0 operating system.
A list of drivers included within Windows CE 3.0 can be viewed on the Windows CE

web site:

http://www.microsoft.com/windows/embedded/ce/tools/hardware/drivers.asp

If drivers are not included for the device being connected, the device manufacturer

needs to provide their own Windows CE 3.0 driver.

3.1USB Keyboard and Mouse
Your Web Tablet can support a USB keyboard and mouse. Below is a list of some

keyboards and Mice that work with the Web Tablet:

Keyboard
Manufacturer Part Number | Interface | Name
Acer 6511-HA USB Aspire Keyboard
BTC BTC-5122U USB BTC Keyboard
Chicony KU-9985 USB Chicony Keyboard
Chicony ACK-600HM | USB Chicony Keyboard
Microsoft USB Microsoft Natural Keyboard

Mouse

Genius Niche USB Genius Mouse
Logitech M-CAB48A USB Logitech Wheel Mouse
Logitech USB Logitech Wheel Mouse, Optical
Logitech M-UB48 USB Logitech Mouse
Microsoft USB Wheel Mouse, Optical
Microsoft USB Microsoft IntelliMouse

For information on using other USB devices, contact peripheral vendor.

A
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You can use an external microphone to improve the quality of your voice recording or
transmissions.

The experience of visiting websites, playing games or MP3 can be enriched through
using external speakers.

Super bass Super bass
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3.4External Display
For presentations or lectures, you can connect a CRT (Cathode Ray Tube Monitor) or
projector via the supplied Mini-VGA cable and Port.

ooioo

4.Getting Online

4.1Establishing a Dial-up Connection
You may already have an ISP (Internet Service Provider), or you may need to ask a
friend or colleague’s recommendation. Once you have joined an ISP, they will
provide you with information you need to quickly connect to the Internet.

Place either a Fax/Modem PCMCIA or CompactFlash card in the appropriate slot and
connect the cable to the phone connection. Go to
Start—Programs—Communication—Remote Networking—Make a New
Connection, and fill in the information as supplied by your ISP.

4.2Connecting to Your Network
In the office, you can connect to your network to go online. When you place your
LAN card in the appropriate slot, a dialogue box appears, asking for IP information.
Your network system administrator will need to supply this information and you will
need to carefully follow their directions.

To check what network drivers are installed on your Web Tablet, go to
Start—Settings—Control Panel >Network. From this point, you can also edit IP
information if necessary, by highlighting the relevant network driver and then
clicking on the properties.
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4.3Ending a Connection

To end a connection, go to the icon in the lower left of your taskbar, double click and
choose ‘Disconnect’.

4.4Setting up Your Email
Your Web Tablet comes with a function-rich email application, designed specifically
for use with Windows CE. To set up your email account, you will need setting
information from your ISP and/or your network system administrator. Go to your
Start—Programs—Applications—Pocket On-Schedule—Inbox. Once inside your

inbox, go to Services—Options. Fill in the appropriate information per your network
system administrator.
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5.Troubleshooting

For problems with your Web Tablet, go to Start—Help. This brings up a general

user guide to reference. Most questions will be able to be answered from this
resource.

51 Common Problems / Frequently Asked Questions

The Web Tablet will not turn on!
eMake sure the Lock/Unlock switch is set to ‘Unlock’
ePress one of the buttons on the front (either button B, C ,D, E, or F
denoted in
elf device does not power on, use the AC Adapter to plug the Tablet into
the wall.

olf this does not turn the Tablet on, push the software reset button located
next to the CompactFlash Slot

e A last resort will be, you will need to use the hardware reset button,
marked on the diagram below. Use a small Philips head screw driver
and remove the screws. Lift the cover and press the reset button.This
will wipe all memory from your Web Tablet.

—_—

I touch the screen with my stylus, and the mouse arrow is in
an entirely different place!
oThis is a sure sign that you need to re-calibrate your touchscreen.

eUse the arrow keys and navigate the mouse arrow. If you press the arrow
buttons and the mouse does not move, press button G. This will
activate the arrow keys for mouse use.

¢Go to Start—Settings—Control Panel—>Stylus
o(Click the calibration tab.

o(Click recalibrate and follow the instructions.
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How do I turn off my Web Tablet?

eYou can turn off your Web Tablet by simply going to the Start Menu and
choosing ‘Suspend’. This will put the device in standby mode. While
the battery is still charged, no data will be lost.

How do I restart my Web Tablet? (If it freezes / hangs up,

or I just loaded new software)

o]f you need to restart you Web Tablet unscrew your stylus, and hit the
software-reset button on the side of the Tablet. If your Web Tablet is
not responding to any commands (that is, it freezes or hangs) you can
use this same reset button. The software-reset button will not affect
data on your Web Tablet system.

olf your system freezes or hangs, and does not respond, even after you hit
the software reset button, first remove the battery to restart the system.
If this does not remedy the situation, you will need to use the hardware
reset button, marked on the diagram below. Use a small Philips head
screw driver and remove the screws. Lift the cover and press the reset
button. This will wipe all memory from your Web Tablet.

My screen is dirty, how can I clean it without harm to the
screen?

®(Clean the screen with a soft, clean cloth and commercial window cleaner
that does not contain wax or abrasives. Always apply the cleaner to
the cloth, not the screen. If the display contains grease or some other
contaminant, use isopropyl alcohol instead of commercial cleaner.
Note: paper toweling and other paper products are abrasive. Be sure to
use a clean cloth when wiping the screen.
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Can I protect my Web Tablet with password access?
eYes, to protect your valuable information, you may want to set up a
password for your Web Tablet. Go to Start—Control

Panel—Password.

5.2 Handwriting Recognition
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Appendix A: Specifications

Processor

Intel Strong ARM 1110 206 MHz and companion chip SA1111

Operating System

Win CE 3.0

Major Application Browser (support plug-in), E-mail, MP3 player, Pocket Office equivalent
Memory 64 or 128 MB SDRAM on board

32MB Flash ROM on board
Optional Storage IBM Micro Drive

Display

10.4” TFT Panel with SVGA resolution support portrait function

Audio System

AC-Link Audio
Internal microphone and one speaker

PCMCIA One PCMCIA Type 1l slot
Compact Flash One compact flash Type 1l slot
External Keyboard USB or PS/2 Keyboard (Optional)
Application Button One application launch dial

One navigations button support mouse-mode & key -mode, “ENTER” key can launch application
One toggle button to switch navigations button between mouse-mode & key-mode

One Page Up/Down dial (lateral)
One power lock switch
One reset switch

Pointing Device

Built-in Touch Panel
Navigations button

Battery Primary battery pack (4-cell) with smart Li-ion battery, 5 hours battery life
Premium battery pack (8-cell) with smart Li-ion battery, 10 hours battery life
Power Adapter Universal AC 90V ~ 265V, 47~63Hz input, 19V DC, 3.16A output, 60W

LED Status Indicator

Green: Power On
Orange: Charging, blinking when battery low

1/0 Port

One PCMCIA Type 11 slot

One compact flash Type II card socket support
One USB Type B connector

One mini-VGA connector

One DC-in jack

One audio jack for external headphone

One audio jack for external Microphone

One cradle connector

Physical

290(W)*213(D)*23.5(H) mm (Min-height)
1150g (with primary battery pack & 10.4” Panel)

Environment

Operating Temperature : 5C~40C
Storage Temperature : -20°C~ 60°C
Operating Humidity : 20% ~ 80%
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